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1.  Installation and Introduction of GeoGebra 

Activity 1: Installing GeoGebra 

Preparations 
Create a new folder called GeoGebra_Workshop on your desktop. 
Hint: During the workshop, save all files into this folder so they are easy to find 
later on. 

Installation WITH Internet access 
Install GeoGebra WebStart 

• Go to www.geogebra.org/webstart  
• Click on the button called GeoGebra WebStart 
• Confirm all messages that might appear with OK or YES 

 
Hint: Using GeoGebra WebStart has several advantages for you provided that 
you have an Internet connection available for the initial installation: 

• You don’t have to deal with different files because GeoGebra is installed 
automatically on your computer. 

• You don’t need to have special user permissions in order to use 
GeoGebra WebStart, which is especially useful for computer labs and 
laptop computers in schools. 

• Once GeoGebra WebStart was installed you can use the software off-line 
as well. 

• Provided you have Internet connection after the initial installation, 
GeoGebra WebStarts frequently checks for available updates and installs 
them automatically. Thus, you are always working with the newest version 
of GeoGebra. 

Installation WITHOUT Internet access 
• Your workshop presenter provides the GeoGebra installer files via USB 

drives or CDs. 
• Copy the installer file from the storage device into the created 

GeoGebra_Workshop folder on your computer  . 
Hint: Make sure you have the correct version for your operating system 
(Windows: GeoGebra_3_0_0_0.exe; MacOS: GeoGebra_3_0_0_0.zip;…). 

• Double-click the GeoGebra installer file and follow the instructions of the 
installer assistant. 
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Activity 2: Distribution of Workshop Files 

Download the necessary workshop files on your computer 
• Your workshop presenter provides them via USB drives or CDs 

o Copy the folder GeoGebra_Introduction_Files from the storage 
device into the created GeoGebra_Workshop folder on your 
computer.  

OR 
• Download the zipped file from www.geogebra.org/??? 

o Save the zipped file in your GeoGebra_Workshop folder. 
o Extract the files on your computer (e.g. WinZip). 

Introduction: What is GeoGebra and How Does It Work? 

Background Information About GeoGebra 
PowerPoint presentation 

GeoGebra’s User Interface  
• Graphics window  
• Geometry tools 
• Toolbar help 
• Show / hide coordinate axes and grid 
• Algebra window  
• Input field 
• Show / hide algebra window and input field 
• Menubar 

Basic Use of Tools 
• Activate a tool by clicking on the button showing the corresponding icon 
• Open a toolbox by clicking on the lower part of a button and select another 

tool from this toolbox  
Hint: You don’t have to open the toolbox every time you want to select a 
tool. If the icon of the desired tool is already shown on the button it can be 
activated directly.   
Hint: Toolboxes contain similar tools or tools that generate the same type 
of new object. 

• Check the toolbar help in order to find out which tool is currently activated 
and how to operate it. 
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2. Drawing versus Geometric Construction 

Activity 3: Drawing Geometric Figures and Other Objects 

Preparations 
Hide the algebra window and 
coordinate axes (View menu). 
 
Show the coordinate grid (View menu). 
 

Drawing pictures with GeoGebra 
Use the mouse and the following selection of tools in order to draw figures on the 
drawing pad (e.g. square, rectangle, house, tree,…). 
 

 New point    New! 

 Move      New! 

 
Line through two points   New! 

 Segment between two points  New! 

 Delete object    New! 

 Undo / Redo buttons   New! 

 Move drawing pad    New! 

 
Zoom in / Zoom out    New! 

What to practice 
• How to select an already existing object.   

Hint: When the pointer hovers above an object, it highlights and the 
pointer changes its shape from a cross to an arrow. Clicking selects the 
corresponding object. 

• How to create a point that lies on and object.  
Hint: The point is displayed in a light blue color. Always check if the point 
really lies on the object by dragging it with the mouse. 

• How to correct mistakes step-by-step using the Undo and Redo buttons. 
 
Tip: A lot of tools allow the creation of points “on the fly”. Therefore, no existing 
objects are required in order to use the tool. 
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Example: Tool Segment between two points can be applied to two already 
existing points or to the empty drawing pad. By clicking on the drawing pad the 
corresponding points are created and a segment is drawn in between them. 

Activity 4: Saving GeoGebra files 

Save your drawing 
• Open the File menu and select Save. 
• Select the folder GeoGebra_Workshop in the appearing dialog window. 
• Type in a name for your GeoGebra file. 
• Click Save in order to finish this process. 

 
Hint: A file with the extension ‘.ggb’ is created. This extension identifies 
GeoGebra files and indicates that they can only be opened with GeoGebra. 
 
Hint: Name your files properly: Avoid using spaces or special symbols in a file 
name since they can cause unnecessary problems when transferred to other 
computers. Instead you can use underscores or upper case letters within the file 
name (e.g. First_Drawing.ggb). 

What to practice 
• How to open a new GeoGebra window (menu File – New window). 
• How to open a blank GeoGebra interface within the same window (menu 

File – New)  
Hint: If you didn’t save the existing construction yet GeoGebra will ask you 
to do so before the blank screen is opened. 

• How to open an already existing GeoGebra file (menu File – Open). 
o Navigate through the folder structure in the appearing window. 
o Select a GeoGebra file (extension ‘.ggb’). 
o Click Open. 
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 Activity 5: Drawings, Constructions, and Drag-Test 

Open the dynamic worksheet A05_Drawing_Construction_Squares.html which 
was provided in the beginning of the workshop and should be saved in your 
GeoGebra_Workshop folder.  
 

 
 
The dynamic figure shows several squares that were constructed in different 
ways.  

• Examine the squares by dragging ALL their vertices with the mouse. 
• Find out which of the quadrilaterals are real squares and which ones just 

happen to look like squares. 
• Write down your conjectures on paper. 

Discussion 
• What is the difference between a drawing and a construction? 
• What is the “drag test” and why is it important? 
• Why is it important to construct figures instead of just drawing them in 

dynamic geometry software?  
• What do we have to know about the geometric figure before we are able 

to construct it in a dynamic geometry software? 
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Activity 6: Rectangle Construction 

Preparations 
• Summarize the properties of a rectangle before you start the construction.  

Hint: If you don’t know the construction steps necessary for a rectangle 
you might want to open the file A06_Rectangle_Construction.ggb. Use the 
buttons of the navigation bar in order to replay the construction process.  

• Open new GeoGebra file. 
• Hide algebra window, input field and coordinate axes (View menu). 
• Change the labeling setting to New points only (menu Options – Labeling). 

Introduction of new tools 
• Perpendicular line and Parallel line tools   

Hint: Click on an already existing line and a point in order to create a 
perpendicular line / parallel line through this point.  

• Intersect two objects tool  
Hint: Click on the intersection point of two objects to get this one 
intersection point. Successively click on both objects to get all intersection 
points. 

• Polygon tool   
Hints: Click on the drawing pad or already existing points in order to create 
the vertices of a polygon. Connect the last and first vertex to close the 
polygon! Always connect vertices counterclockwise! 

 
Hint: Don’t forget to read the toolbar help if you don’t know how to use a tool.  
Hint: Try out all new tools before you start the construction. 

 



 

GeoGebra Introductory Workshop   
 

 

 10

Construction process 

1  Segment AB 

2  Perpendicular line to segment AB through point B 

3  New point C on perpendicular line 

4  Parallel line to segment AB through point C 

5  Perpendicular line to segment AB through point A 

6  Intersection point D 

7  Polygon ABCD 

  Hint: To close the polygon click on the first vertex again. 

8  Save the construction 

Check your construction  
1. Apply the drag test to check if the construction is correct. 
2. Show the Navigation bar (View menu) to review your construction step-by-

step using the buttons. 
3. Show the construction protocol (View menu) and use it to review your 

rectangle construction step-by-step. 
o Try to change the order of some construction steps by dragging a 

line with the mouse. Why does this NOT always work? 
o Group several constructions steps by setting breakpoints: 

• Show the column Breakpoint (View menu of the construction 
protocol window) 

• Group construction steps by checking the Breakpoint box of 
the last one of the group  

• Change setting to Show only breakpoints (View menu of the 
construction protocol window) 

• Use the navigation bar to review the construction step-by-
step. Did you set the breakpoints correctly? 
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Activity 7: Equilateral Triangle Construction 

Preparations 
• Summarize the properties of an equilateral triangle before you start the 

construction.  
Hint: If you don’t know the construction steps necessary for an equilateral 
triangle you might want to have a look at the following file: 
A07_Equilateral_Triangle_Construction.ggb. Use the buttons of the 
navigation bar in order to replay the construction process.  

• Open new GeoGebra file. 
• Hide algebra window, input field and coordinate axes (View menu). 
• Change the labeling setting to New points only (menu Options – Labeling). 

Introduction of new tools 
• Circle with center through point tool  

Hint: First click creates center, second click determines radius of the 
circle. 

• Show / hide object tool   
Hints: Highlight all objects that should be hidden, then switch to another 
tool in order to apply the visibility changes! 

• Angle tool  
Hint: Click on the points in counterclockwise direction! GeoGebra always 
creates angles with mathematically positive orientation. 

 
Hint: Don’t forget to read the toolbar help if you don’t know how to use a tool.  
Hint: Try out all new tools before you start the construction. 
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Construction process 

1  Segment AB 

2  Circle with center A through B 

  Hint: Drag points A and B to check if circle is connected to them. 

3  Circle with center B through A 

  Hint: Drag points to check if circle is connected to them. 

4  Intersect both circles to get point C 

5  Polygon ABC in counterclockwise direction 

6  Hide circles 

7  Show interior angles of triangle 

  Hint: Clockwise creation of the polygon gives you the exterior 
angles! 

8  Save the construction 

Check your construction  
1. Apply the drag test to check if the construction is correct. 
2. Show the navigation bar or use the construction protocol to review your 

construction step-by-step. 

Use the Properties dialog to enhance your construction 
There are different ways to access the Properties dialog: 

• Right-click (MacOS: Ctrl-click) an object 
• Select Properties… from the Edit menu 
• Double click an object in Move mode 

What to practice… 
• Select different objects from the list on the left hand side and explore the 

available properties tabs for different types of objects 
• Select several objects in order to change a certain property for all of them 

at the same time   
Hint: Hold the Ctrl-key pressed and select all desired objects. 

• Select all objects of one type by clicking on the heading of the 
corresponding object group. 

• Show the value of different objects and try out different label styles. 
• Change the properties of certain objects (e.g. color, style,…) 
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3. Practice Block I 
This practice block consists of a pool of geometry activities of two different 
difficulty levels: Basic tasks and Advanced tasks. You can pick tasks of your 
interest and work on them either on your own or together with a colleague. 

Tips and Tricks 

• Summarize the properties of the geometric figure you want to create. 
• Try to find out which GeoGebra tools can be used in order to construct the 

figure using some of these properties   
(e.g. right angle – tool Perpendicular line).  

• Make sure, you know how to use each tool before you begin the 
construction. If you don’t know how to operate a certain tool, activate it 
and read the toolbar help. 

• For each of these activities, open a new GeoGebra file, hide the algebra 
window, input field, and the coordinate axes. 

• You might want to save your files before you start a new activity. 
• Don’t forget about the Undo and Redo buttons in case you make a 

mistake. 
• Frequently use the Move tool in order to check your construction (e.g. are 

objects really connected, did you create any unnecessary objects). 
• If you have questions, please ask a colleague before you address the 

presenter or assistant(s). 
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Activity I.a: Square Construction 

Classification: Basic task 
 
In this activity you are going to use the following tools. Make sure you know how 
to use every single tool before you begin with the actual construction of the 
square: 
 

 Segment between two points  Polygon 

 Perpendicular line  Show / hide object 

 Circle with center through point  Move 

 Intersect two objects    
 
Hint: You might want to have a look at the file A_1a_Square_Construction.html if 
you are not sure about the construction process. 
 

Construction process 
1. Draw segment a = AB between points A and B 
2. Construct perpendicular line b to segment AB through point B 
3. Construct circle c with center B through point A 
4. Intersect circle c with perpendicular line b to get intersection point C 
5. Construct perpendicular line d to segment AB through point A 
6. Construct circle e with center A through point B 
7. Intersect perpendicular line d with circle e to get intersection point D 
8. Create polygon ABCD.  

Hint: Don’t forget to close the polygon by clicking on point A after selecting 
point D. 

9. Hide circles and perpendicular lines 
10. Perform the drag test to check if your construction is correct 

 
Challenge: Can you come up with a different way of constructing a square? 
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Activity I.b: Regular Hexagon Construction 

Classification: Basic task 
 
In this activity you are going to use the following tools. Make sure you know how 
to use every single tool before you begin with the actual construction of the 
square: 
 

 Circle with center through point  Angle 

 Intersect two objects  Show / hide object 

 Polygon  Move 
 
Hint: You might want to have a look at the file A_1b_Hexagon_Construction.html 
if you are not sure about the construction process. 
 

Construction process 
1. Draw a circle with center A through point B 
2. Construct another circle with center B through point A 
3. Intersect the two circles in order to get the vertices C and D. 
4. Construct a new circle with center C through point A. 
5. Intersect the new circle with the first one in order to get vertex E. 
6. Construct a new circle with center D through point A. 
7. Intersect the new circle with the first one in order to get vertex F. 
8. Construct a new circle with center E through point A. 
9. Intersect the new circle with the first one in order to get vertex G. 
10. Draw hexagon FGECBD. 
11. Create the angles of the hexagon. 
12. Perform the drag test to check if your construction is correct. 

 
Challenge: Try to find an explanation for this construction process.  
Hint: Which radius do the circles have and why? 
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Activity I.c: Circumscribed Circle of a Triangle 

Classification: Advanced task 
 

In this activity you are going to use the following tools. Make sure you know how 
to use every single tool before you begin with the actual construction of the 
square: 
 

 Polygon  
 Circle with center through point 

 Line bisector   New!  
 Move 

 Intersect two objects    
 
Hint: If you are not sure about the construction process, you might want to have a 
look at the file A_1c_Circumcircle_Triangle_Construction.html. 
 

Construction process 
1. Create an arbitrary triangle ABC 
2. Construct the line bisector for each of the triangle sides  

Hint: Tool Line bisector can be applied to an existing segment. 
3. Create intersection point D of two of the line bisectors  

Hint: Tool Intersect two objects requires can’t be applied to the 
intersection of three lines. Either select two of the three line bisectors 
successively, or click on the intersection point and select one line at a time 
from the appearing list of objects in this position. 

4. Construct a circle with center D through one of the vertices of triangle ABC 
5. Perform the drag test to check if your construction is correct. 

 
Challenge: Modify your construction to answer the following questions: 

1. Can the circumcenter of a triangle lie outside the triangle? If yes, for which 
types of triangles is this true? 

2. Try to find an explanation for using line bisectors in order to create the 
circumcenter of a triangle. 
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Activity I.d: Visualize the Theorem of Thales 

Classification: Advanced task 
 
Before you begin this construction, check out the dynamic worksheet called 
Theorem_Thales.html in order to see how students could rediscover what Thales 
found out about 2600 years ago. 
 
 
In this activity you are going to use the following tools. Make sure you know how 
to use every single tool before you begin with the actual construction of the 
square: 
 

 Segment between two points  
 Polygon 

 Semicircle through two points  New!  
 Angle 

 New point  
 Move 

 
Hint: If you are not sure about the construction process, you might want to have a 
look at the file A_1d_Theorem_Thales_Construction.html. 
 

Construction process 
1. Draw segment AB 
2. Construct a semicircle through points A and B  

Hint: The order of clicking points A and B determines the direction of the 
semicircle. 

3. Create a new point C on the semicircle  
Hint: Check if point C really lies on the arc by dragging it with the mouse. 

4. Create triangle ABC 
5. Create the interior angles of triangle ABC 

 
Challenge: Try to come up with a graphical proof for this theorem. 
Hint: Create midpoint O of segment AB and display the radius OC as a segment. 
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4. Basic Algebraic Input, Commands, and Functions 

Tips and Tricks 

• Name a new object by typing in name = in front of its algebraic 
representation. Example: P = (3, 2) creates point P. 

• Multiplication needs to be entered using an asterisk or space between 
the factors. Example: a*x or a x 

• GeoGebra is case sensitive! Thus, upper and lower case letters must 
not be mixed up. Note: 

o Points are always named with upper case letters  
Example: A = (1, 2) 

o Segments, lines, circles, functions… are always named with lower 
case letters.  
Example: circle c: (x – 2)^2 + (y – 1)^2 = 16 

o The variable x within a function and the variables x and y in the 
equation of a conic section always need to be lower case.  
Example: f(x) = 3*x + 2 

• If you want to use an object within an algebraic expression or 
command you need to create the object prior to using its name in the input 
field. Examples:  

o y = m x + b creates a line whose parameters are already 
existing values m and b (e.g. numbers / sliders). 

o Line[A, B] creates a line through existing points A and B. 
• Confirm an expression you entered into the input field by pressing the 

Enter key. 
• Open the help window for using the input field and commands by clicking 

the question mark  to the left of the input field. 
• Error messages: Always read the messages – they could possibly help to 

fix the problem! 
• Commands can be typed in or selected from the list next to the input field.  

Hint: If you don’t know which parameters are required within the brackets 
of a certain command, type in the full command name and press key F1. A 
pop-up window appears explaining the syntax and necessary parameters 
of the command. 

• Automatic completion of commands: After typing in the first two letters 
of a command into the input field, GeoGebra tries to complete the 
command.  

o If GeoGebra suggests the desired command, hit the Enter key in 
order to place the cursor within the brackets.  

o If the suggested command is not the one you wanted to enter, just 
keep typing until the suggestion matches. 



 

GeoGebra Introductory Workshop   
 

 

 19

Activity 8a: Constructing Tangents to a Circle (Part 1) 

Back to school… 
Open the dynamic worksheet A08_Tangents_Circle.html. Follow the directions 
on the worksheet in order to find out how to construct tangents to a circle. 
 

 

Discussion 
• Which tools did you use in order to recreate the construction?  
• Were there any new tools involved in the suggested construction process? 

If yes, how did you find out how to operate the new tool?  
• Did you notice anything about the toolbar displayed in the right applet?  
• Do you think your students could work with such a dynamic worksheet and 

find out about construction processes on their own? 
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Activity 8b: Constructing Tangents to a Circle (Part 2) 

What if my Mouse and Touchpad wouldn’t work? 
Imagine your mouse and / or touchpad stop working while you are preparing 
GeoGebra files for tomorrow’s lesson. How can you finish the construction file? 
 
GeoGebra offers algebraic input and commands in addition to the geometry 
tools. Every tool has a matching command and therefore, could be applied 
without even using the mouse. 
Note: GeoGebra offers more commands than geometry tools. Therefore, not 
every command has a corresponding geometry tool! 
 
Task 1: Check out the list of commands next to the input field and look for 
commands whose corresponding tools were already introduced in this workshop. 
 
As you saw in the last activity, the construction of tangents to a circle can be 
done by using geometric construction tools only. Anyway, you will now recreate 
this construction by just using keyboard input. 

Preparations 
• Open a new GeoGebra file. 
• Show the algebra window and input field, as well as coordinate axes (View 

menu) 

Construction process 

1 A = (0, 0) Point A 

  Hint: Make sure to close the parenthesis. 

2 (3, 0) Point B 

  Hint: If you don’t specify a name objects are named 
in alphabetical order. 

3 c = Circle[A, B] Circle with center A through point B 

  Hint: Circle is a dependent object 

 
Note: GeoGebra distinguishes between free and dependant objects. While free 
objects can be directly modified either using the mouse or the keyboard, 
dependant objects adapt to changes of their parent objects. Thereby, it is 
irrelevant in which way (mouse or keyboard) an object was initially created! 
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Hint 1: Activate Move mode and double click an object in the algebra window in 
order to change its algebraic representation using the keyboard. Hit the Enter key 
once you are done. 
 
Hint 2: You can use the arrow keys in order to move free objects in a more 
controlled way. Activate move mode and select the object (e.g. a free Point) in 
either window. Press the up / down or left / right arrow keys in order to move the 
object into the desired direction. 
 

4 C = (5, 4) Point C 

5 s = Segment[A, C] Segment AC 

7 D = Midpoint[s] Midpoint D of segment AC 

8 d = Circle[D, C] Circle with center D through point C 

9 Intersect[c, d] Intersection points E and F of the two circles 

10 Line[C, E] Tangent through points C and E 

11 Line[C, F] Tangent through points C and F 

 

 

Checking and enhancing the construction 
• Perform the drag-test in order to check if the construction is correct. 
• Change properties of objects in order to improve the construction’s 

appearance (e.g. colors, line thickness, auxiliary objects dashed,…) 
• Save the construction. 
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Discussion 
• Did any problems or difficulties occur during the construction process? 
• Which version of the construction (mouse or keyboard) do you prefer and 

why? 
• Why should we use keyboard input if we could also do it using tools?  

Hint: There are commands available that have no equivalent geometric 
tool. 

• Does it matter in which way an object was created? Can it be changed in 
the algebra window (using the keyboard) as well as in the graphics 
window (using the mouse)? 



 

GeoGebra Introductory Workshop   
 

 

 23

Activity 9: Exploring Parameters of a Quadratic Polynomial 

Back to school… 
In this activity you will explore the impact of parameters on a quadratic 
polynomial. You will experience how GeoGebra could be integrated into a 
‘traditional’ teaching environment and used for active, student-centered learning. 
 
Follow the instructions on the paper worksheet and write down your results and 
observations while working with GeoGebra. Your notes will help you during the 
following discussion of this activity. 
 

 
Exploring Parameters of a Quadratic Polynomial 

 
1. Open a new GeoGebra file 

 
2. Type in f(x) = x^2 and hit the Enter key. Which shape does the function 

graph have? Write down your answer on paper. 
 

3. In  Move mode, highlight the polynomial in the algebra window and use the 
↑ up and ↓ down arrow keys. 

a. How does this impact the graph of the polynomial? Write down your 
observations. 

b. How does this impact the equation of the polynomial? Write down 
your observations. 

 
4. Again, in Move mode, highlight the function in the algebra window and use 

the ← left and → right arrow keys.  
a. How does this impact the graph of the polynomial? Write down your 

observations. 
b. How does this impact the equation of the polynomial? Write down 

your observations. 
 

5. In Move mode, double click the equation of the polynomial. Use the 
keyboard to change the equation to f(x) = 3 x^2.  
Hint: Use an asterisk * or space in order to enter a multiplication. 

a. Describe how the function graph changes. 
b. Repeat changing the equation by typing in different values for the 

parameter (e.g. 0.5, -2, -0.8, 3). Write down your observations 
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Discussion 
• Did any problems or difficulties concerning the use of GeoGebra occur? 
• How can a setting like this (GeoGebra in combination with instructions on 

paper) be integrated into a ‘traditional’ teaching environment? 
• Do you think it is possible, to give such an activity as a homework problem 

to your students? 
• In which way could the dynamic exploration of parameters of a polynomial 

possibly affect your students’ learning? 
• Do you have ideas for other mathematical topics that could be taught in 

similar learning environment (paper worksheets in combination with 
computers)? 
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Activity 10: Using Sliders to Modify Parameters 

Let’s try out a more dynamic way of exploring the impact of a parameter on a 
polynomial f(x) = a x^2 by using sliders to modify the parameter values. 

Preparation 
• Open a new GeoGebra file  
• Show the algebra window, input field, and coordinate axes (View menu) 

Construction process 

1 a = 1 Create the variable a 

2 f(x) = a * x^2 Enter the quadratic polynomial f 

  Hint: Don’t forget to enter an asterisk * or space 
between a and x^2. 

Representing a number as a slider 
To display number as a slider in the graphics window you need to right click 
(MacOS: Ctrl-click) the variable in the algebra window and select Show object.  

Enhancing the construction 
Let’s create another slider b that controls the constant in the polynomial’s 
equation f(x) = a x^2 + b. 
 

5 
 

Create a slider b using the Slider tool 

  Hint: Activate the tool and click on the drawing 
pad. Use the default settings and click Apply. 

6 f(x) = a * x^2 + b Enter the polynomial f 

  Hint: GeoGebra will overwrite the old function f 
with the new definition. 

Tasks 
• Change the parameter value a by moving the point on the slider with the 

mouse. How does this influence the graph of the polynomial? 
• What happens to the graph when the parameter value is (a) greater than 

1, (b) between 0 and 1, or (c) negative? Write down your observations. 
• Change the parameter value b. How does this influence the graph of the 

polynomial? 
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 Activity 11: Library of functions 

Apart from polynomials there are different types of functions available in 
GeoGebra (e.g. trigonometric functions, absolute value function, exponential 
function). Functions are treated as objects and can be used in combination with 
geometric constructions. 
 
Note: Some of the functions available can be selected from the menu next to the 
input field. Please find a complete list of functions supported by GeoGebra in the 
GeoGebra online help document (http://www.geogebra.org/help/docuen ). 

Task 1: Visualizing absolute values 
Open a new GeoGebra file. Make sure the algebra window, input field, and 
coordinate axes are shown. 
 

1 f(x) = abs(x) Enter the absolute value function f 

2 g(x) = 3 Enter the constant function g 

3 
 

Intersect both functions 

Hint: You might want to close the algebra window and show the names and 
values as labels of the objects. 
 
(a) Move the constant function 
with the mouse or using the 
arrow keys. The y-coordinate of 
each intersection point 
represents the absolute value of 
the x-coordinate.  
 
(b) Move the absolute value 
function up and down either using 
the mouse or the arrow keys. In 
which way does the function’s 
equation change?  
 
(c) How could this construction be used in order to familiarize students with the 
concept of absolute value?  
Hint: The symmetry of the function graph indicates that there are usually two 
solutions for an absolute value problem. 
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Task 2: Superposition of sine waves 
Sound waves can be mathematically represented as a combination of sine 
waves. Every musical tone is composed of several sine waves of the form 

)tsine( a  y(t) ϕω += . The amplitude a influences the volume of the tone while the 
angular frequency ω determines the pitch of the tone. The parameter φ is called 
phase and indicates if the sound wave is shifted in time. 
 
If two sine waves interfere, superposition occurs. This means that the sine waves 
amplify or diminish each other. We can simulate this phenomenon with 
GeoGebra in order to examine special cases that also occur in nature.  
 

1 
 

Create three sliders a_1, ω_1, and φ_1 

  
Hints: a_1 produces an index. You can select 
the Greek letters from the menu next to the 
text field name in the Slider dialog window. 

2 g(x)= a_1 sin(ω_1 x + φ_1) Enter the sine function g 

  Hint: Again, you can select the Greek letters 
from a menu next to the input field. 

 
(a)  Examine the impact of the parameters on the graph of the sine functions 

by changing the values of the sliders. 
 

3 
 

Create three sliders a_2, ω_2, and φ_2 

4 h(x)= a_2 sin(ω_2 x + φ_2) Enter another sine function h 

5 sum(x) = g(x) + h(x) Create the sum of both functions 

 
(b)  Change the color of the three functions so they are easier to identify. 
 
(c)  Set a1 = 1, ω1 = 1, and  
φ1 = 0. For which values of a2, 
ω2, and φ2 does the sum have 
maximal amplitude? 
Hint: In this case the resulting 
tone has the maximal volume. 
 
(d)  For which values of a2, 
ω2, and φ2 do the two functions 
cancel each other? 
Hint: In this case no tone can be 
heard any more. 
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5. Export of Pictures to the Clipboard 
GeoGebra’s drawing pad can be exported as a picture to your computer’s 
clipboard. Thus, they can be easily inserted into text processing or presentation 
documents allowing you to create appealing sketches for tests, quizzes, notes, or 
mathematical games. 

Activity 12a: Exporting Pictures to the Clipboard 

Create your sketch 
Open a new GeoGebra document and make sure the algebra window, input field, 
and coordinate axes are shown. 
 

1 f(x) = 0.5x3 + 2x2 + 0.2x - 1 Enter the cubic polynomial f 

2 R = Root[ f ] Create the roots of polynomial f 

  
Hint: If there are more than one root 
GeoGebra will produce indices for their 
names if you type in R = (e.g. R1, R2, R3). 

3 E = Extremum[ f ] Create the extrema of polynomial f 

4 
 

Create tangents to f in E1 and E2 

5 I = InflectionPoint[ f ] Create the inflection point of polynomial f 

 
Hint: You might want to change properties of objects (e.g. color of points, style of 
the tangents, show name and value of the function). 
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Exporting a picture to the clipboard 
GeoGebra will export the whole graphics window into the clipboard. Thus, you 
need to make the GeoGebra window smaller in order to reduce unnecessary 
space on the drawing pad: 

• Move your figure (or the relevant section) to the upper left corner of the 
drawing pad using the  Move drawing pad tool (see left figure below).  
Hint: You might want to use tools  Zoom in and  Zoom out in order to 
prepare your figure for the export process. 

• Reduce the size of the GeoGebra window by dragging its lower right 
corner with the mouse (see right figure below).  
Hint: The pointer will change its shape when hovering above an edges or 
corner of the GeoGebra window. 

 
 

GeoGebra window before 
the size reduction 

 GeoGebra window after 
the size reduction 

 
Use the File menu to export the drawing pad to the clipboard: 

• Export – Drawing Pad to Clipboard  
Hint: You could also use the key combination Ctrl – Shift – C. 

• Your figure is now stored in your computer’s clipboard and can be inserted 
into any word processing or presentation document. 
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Activity 12b: Inserting Pictures into a Text Processing Document 

Inserting pictures from the clipboard 
After exporting a figure from GeoGebra into your computer’s clipboard you can 
now paste it into a word processing document (e.g. MS Word). 

• Open a new text processing document 
• From the Edit menu select Paste. The picture is inserted at the position of 

the cursor.  
Hint: You can use the key combination Ctrl – V instead. 

Reducing the size of pictures 
If necessary you can reduce the size of the picture in MS Word: 

• Double click the inserted picture. 
• Select the Size tab in the appearing window. 
• Change height / width of the picture either in inches or percent. 
• Click OK. 

 
Note: If you change the size of a picture, the scale is modified. If you want to 
maintain the scale (e.g. for your students to measure lengths) make sure the size 
of the picture is 100%. 
 
Note: If a picture is too big to fit on one page MS Word will reduce its size 
automatically and thus, change its scale. 
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6. Practice block II 
This practice block consists of a pool of activities to practice using algebraic 
input, commands, and functions in GeoGebra. Activities of two different difficulty 
levels are available: Basic tasks and Advanced tasks. You can pick tasks of your 
interest and work on them either on your own or together with a colleague. 

Tips and Tricks 

• For each of these activities, open a new GeoGebra file. Check prior to 
beginning the activity if you need to show or hide the algebra window, 
input field, and coordinate axes. 

• You might want to save your files before you start a new activity. 
• Don’t forget about the Undo and Redo buttons in case you make a 

mistake. 
• Frequently use the Move tool in order to check your construction (e.g. are 

objects really connected, did you create any unnecessary objects). 
• Make sure you know the syntax to enter algebraic expressions and 

functions. Read through the Tips and Tricks section in the beginning of 
topic Basic Algebraic Input, Commands, and Functions if you have 
troubles or ask colleagues for help. 

• Carefully check algebraic input before hitting the Enter key. If an error 
message appears, read it! It might help you to fix the problem. 

• Make sure, you know how to use corresponding geometry tools before 
you begin the construction. If you don’t know how to operate a certain tool, 
activate it and read the toolbar help. 

• If you have questions, please ask a colleague before you address the 
presenter or assistant(s). 
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Activity II.a: Parameters of a Linear Equation 

Classification: Basic task 
 
In this activity you are going to use the following tools, algebraic input, and 
commands. Make sure you know how to use them before you begin with the 
actual construction. 
 

 Slider  Intersect two objects 
 line: y = m x + b   Slope    New! 

 Segment between two points  Show / hide object 
 Intersect[line, yAxis]  Move 

 
Hint: You might want to have a look at the file A_2a_parameters_line.html first. 
 

Construction process 
1. Enter: line: y = 0.8 x + 3.2  

Task 1: Move the line in the algebra window using the arrow keys. Which 
parameter are you able to change in this way?  
Task 2: Move line in the graphics window with the mouse. Which 
transformation can you apply to the line in this way? 

2. Delete the line. Create sliders m and b using the default settings of sliders. 
3. Enter line: y = m x + b.  

Hint: Don’t forget to use an asterisk of 
space to indicate multiplication! 

4. Task 3: Write down directions for your 
students that guide them through 
examining the influence of the 
equation’s parameters on the line by 
using the sliders. These directions could 
be provided on paper along with the GeoGebra file. 

 
 
Challenge: Enhance this construction by showing the slope and y-intercept. 

5. Create the intersection point between the line and the y-axis.  
Hint: Use tool  Intersect or command Intersect[line, yAxis]. 

6. Create a point at the origin and draw a segment between these two points. 
7. Use tool  Slope and create the slope (triangle) of the line. 
8. Hide unnecessary objects and modify the appearance of the other ones. 
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 Activity II.b: Introducing Derivatives – The Slope Function 

Classification: Advanced task 
 
In this activity you are going to use the following tools, algebraic input, and 
commands. Make sure you know how to use them before you begin with the 
actual construction. 
 
 f(x) = x^2/2 + 1   S = (x(A), slope) 

 New point  Segment between two points 

 Tangent   New!  Move 
 slope = Slope[t]    

 
Hint: You might want to have a look at the file A_2b_slope_function.html first. 
 

Construction process 
1. Enter the polynomial: f(x) = x^2/2 + 1 
2. Create new point A on function f.  

Hint: Move point A to check if it is really restricted to the function graph. 
3. Create tangent t to function f through point A. 
4. Create the slope of tangent t using: 

slope = Slope[t]  
5. Define point S: S = (x(A), slope)  

Hint: x(A) gives you the x-coordinate of 
point A. 

6. Connect points A and S using a 
segment. 

7. Task: Move point A along the function 
graph and make a conjecture about the 
shape of its path, which corresponds to 
the slope function.  

 
 
Challenge: Find the equation of the slope function. 

8. Turn on the trace of point S. Move point A to check your conjecture.   
Hint: Right click point S (MacOS: Ctrl-click) and select  Trace on. 

9. Find the equation of the resulting slope function. Enter the function and 
move point A. If it is correct the trace of point S will match the graph. 

10. Change the equation of the initial polynomial f to produce a new problem. 
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Activity II.c: Creating a ‘Function Domino’ Game 

Classification: Basic task 
 
In this activity you are going to practice exporting function graphs to the clipboard 
and inserting them into a word processing document in order to create cards for 
a ‘Function Domino’ game. Make sure you know how to enter different types of 
functions before you begin with this activity. 
 

Creation process 
1. Enter an arbitrary function. Example: e(x) = exp(x) 
2. Move the function graph into the upper left corner of the drawing pad and 

adjust the size of the GeoGebra window. 
3. Export the drawing pad to the clipboard (menu File – Export – Drawing 

Pad to Clipboard). 
4. Open a new word processing document. 
5. Create a table (menu Table – Insert – Table…) with two columns and 

several rows. 
6. Place the cursor in one of the table cells. Insert the function graph from 

the clipboard (menu Edit – Paste or key combination Ctrl – V). 
7. Adjust the size of the picture if necessary (double click the picture to open 

the Format Picture dialog window, then click on tab Size). 
8. Enter the equation of a different function into the cell next to the picture.  

Hint: You might want to use an equation editor. 
9. Repeat steps 1 through 8 with a different function (e.g. trigonometric, 

logarithmic).  
Hint: Make sure to put the equation and graph of each function on different 
domino cards. 
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Activity II.d: Creating a ‘Geometric Figures Memory’ Game 

Classification: Advanced task 
 
In this activity you are going to practice exporting function graphs to the clipboard 
and inserting them into a word processing document in order to create cards for 
a memory game with geometric figures. Make sure you know how to construct 
different geometric figures (e.g. quadrilaterals, triangles) before you begin with 
this activity. 
 

Creation process 
1. Create a geometric figure in GeoGebra (e.g. isosceles triangle). 
2. Use the Properties dialog to enhance your construction. 
3. Move the figure into the upper left corner of the drawing pad and adjust 

the size of the GeoGebra window. 
4. Export the drawing pad to the clipboard (menu File – Export – Drawing 

Pad to Clipboard). 
5. Open a new word processing document. 
6. Create a table (menu Table – Insert – Table…) with three columns and 

several rows. 
7. Set the height of the rows and the width of the columns to 2 inches.  

Hint: Place the cursor in the table and open the Table Properties dialog 
using the Table menu. On tab Row specify the row height. On tab Column 
enter the preferred width. On tab Cell set the vertical alignment to Center. 
Click OK when you are done. 

8. Place the cursor in one of the table cells. Insert the picture from the 
clipboard (menu Edit – Paste or key combination Ctrl – V). 

9. Adjust the size of the picture if necessary (double click the picture to open 
the Format Picture dialog window, click on tab Size and specify the size). 

10. Enter the name of the geometric shape into another cell of the table. 
11. Repeat steps 1 through 10 with different geometric figures (e.g. circle, 

quadrilaterals, triangles).  
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7.  Inserting Pictures into the Graphics Window 

Activity 13: Drawing Tool for Symmetric Figures 

Back to school… 
Open the dynamic worksheet A13_drawing_tool_symmetry.html. Follow the 
directions on the worksheet and experience how your students could explore the 
axes of symmetry of a flower.  
Hint: You will learn how to create such dynamic worksheets later in this 
workshop. 
 

 

Discussion 
• How could your students benefit from this prepared construction? 
• Which tools were used in order to create the dynamic figure? 

Preparations 
• Open a new GeoGebra file. 
• Hide algebra window, input field, and coordinate axes (View menu). 

Construction process 

1  New point A 

2  Show the label of point A 

3  Line of reflection through two points 

4  Mirror point at line to get image A’  
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5  Segment between point A and its image A’ 

7  Turn the Trace on for points A and A′ 

  
Hint: Right click (MacOS: Ctrl – click) the point and select Trace on 
from the menu. Whenever point A is moved it leaves a trace on the 
drawing pad. 

8  Move point A to draw a dynamic figure 

Discussion 
The  Trace on feature has some special characteristics: 

• The trace is a temporary phenomenon. Whenever the graphics are 
refreshed, the trace disappears. 

• The trace can’t be saved and is not shown in the algebra window. 
• To delete the trace you need to refresh the views (menu View – Refresh 

views or key combination Ctrl – F). 

Enhancing the construction 
Note: Make sure you have the picture file of the flower saved on your computer. 
 

9  Insert image into the drawing pad 

  Hint: Click in the lower left corner of the drawing pad to insert the 
picture at this position. 

10  Adjust the position of the inserted image. 

11  Set the image as background image (Properties dialog, tab Basic). 

12  Reduce the filling of the image (Properties dialog, tab Style). 

  
Hint: After specifying the picture as a background image you need 
to open the Properties dialog using the Edit menu. You can’t select 
a background image in the graphics window any more. 
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Activity 14a: Resizing and Reflecting a Picture 

In this activity you will to learn how to resize an inserted picture to a certain size 
and how to apply transformations to the picture in GeoGebra. 

Preparations 
• Make sure you have the picture A14_Sunset_Palmtrees.jpg saved on your 

computer. 
• Open a new GeoGebra file.  
• Close the algebra window and hide the coordinate axes. 

Construction process 

1  Insert picture A14_Sunset_Palmtrees.jpg no the left part of the 
drawing pad 

2  New point A at the lower left corner of the picture 

3  Set point A as the first corner point of your picture. 

  
Hint: Open the Properties dialog and select the picture in the list of 
objects. Click on tab ‘Basic’ and select point A from the drop-down 
list next to Corner 1. 

4  B = A + (3, 0) 

5  Set point B as the second corner point of the picture. 

  Hint: You just changed the width of the picture to 3 cm. 

6  Vertical line through two points in the middle of the drawing pad 

7 
 

Mirror the picture at the line 

  Hint: You might want to reduce the filling of the image in order to be 
able to better distinguish it from the original. 

Tasks 
(a) Move point A with the mouse. How 
does this affect the picture? 
(b) Move the picture with the mouse and 
observe how this affects its image. 
(c) Move the line of reflection by 
dragging the two points with the mouse. 
How does this affect the image? 
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Activity 14b: Distorting a Picture 

In this activity you will to learn how to resize an inserted picture to an arbitrary 
size and how to distort a picture in GeoGebra. 
You will now modify the construction created in activity 14a. If you want to keep 
the original as well you need to save your file. 

Construction process 

1  Start with the figure you created in activity 14a. 

2  Delete the point B to restore the picture’s original size 

3  Create a new point B at the lower right corner of the original picture 

4  Set the new point B as the second corner point of your picture. 

  Hint: You can now resize the image by moving point B. 

5  Create a new point D at the upper left corner of the original picture 

6  Set the new point D as the fourth corner point of your picture 

Tasks 
(a) How does moving point D affect the picture and its image? 
(b) Why doesn’t it make sense to also set the third corner point of the picture? 
(c) Which geometric shape do the picture and the image form at any time? 
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Activity 14c: Exploring Properties of Reflection 

In this activity you will create a dynamic figure that allows your students to 
explore the properties of reflection. 
You will now modify the construction created in activity 14b. If you want to keep 
the original as well you need to save your file. 

Construction process 

1  Start with the figure you created in activity 14b. 

2  Segment between points A and B 

3 
 

Segment between points A and D 

4 
 

Parallel line to segment AB through point D 

5 
 

Parallel line to segment AD through point B 

6 
 

Intersect the two lines to get intersection point C 

7  Hide auxiliary objects 

8  Reflect all four corner points at the line to get their images 

9  Connect corresponding points with segments (e.g. points A and A’) 

10 
 

Create angles between the line of reflection and the segments 

Task 
Move the corner points of the original picture, as well as the line of reflection. 
What do you notice about the angles between the segments and the line of 
reflection? 
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8. Inserting Text into the Graphics Window 

Activity 15: Coordinates of Reflected Points 

Preparations 
• Open a new GeoGebra file. 
• Show the algebra window, input field, coordinate axes, and the grid (View 

menu). 
• In the Options menu set the Point capturing to on (Grid). 

 

1  Create point A = (3, 2) 

2  Create line a: y = 0 

3  Mirror point A at line a to get point A’ 

4  Change the color of line a and point A’. 

5  Create line b: x = 0 

6  Mirror point A at line b to get point A1’ 

7  Change the color of line b and point A1’. 

Inserting static text 
Insert a heading into the graphics window of GeoGebra so your students know 
what this dynamic figure is about: 

• Activate the  Text tool and click on the upper part of the drawing pad. 
• Type the following text into the appearing window:   

Reflecting a point at the coordinate axes 
• Click Apply. 
• Adjust the position of the text using the Move tool. 

 
Hints: You can change the properties of the text in the Properties dialog (e.g. 
wording, font style, font size, formatting). On tab Basic you can fix the position of 
the text so it can’t be moved accidentally any more. 

Inserting dynamic text 
Dynamic text refers to existing objects and adapts automatically to modifications, 
for example A = (3, 2). 
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• Activate the  Text tool and click on the drawing pad. 
• Type A = into the appearing window:  

Hint: This will be the static part of the text and won’t change if point A is 
moved. 

• Insert the dynamic part of this text by clicking on point A either in the 
algebra or the graphics window.  

o GeoGebra will insert the name of the point into the text field and 
add quotation marks around the already existing (static) text.  

o Additionally, GeoGebra adds a + symbol to connect the static and 
dynamic part of the text. 

• Click Apply. 
 
Note: The text shows the coordinates of point A and adapts automatically to 
modifications of its position. 

Enhancing the dynamic figure 
• Insert dynamic text that shows the coordinates of the reflected points A’ 

and A1’. 
• Zoom out in order to show a larger part of the coordinate plane.  

Hint: You might want to adjust the distance of the grid lines.  
o Open the Properties dialog for the drawing pad (right click / MacOS: 

Ctrl-click the drawing pad and select Properties) 
o Select tab Grid 
o Check the box next to Distance and change the values in both text 

fields to 1 
• Close the algebra window and fix all text so it can’t be moved accidentally. 

 

 

Task 
Come up with instructions to guide your students towards discovering the relation 
between the coordinates of the original and the reflected points which could be 
provided along with the dynamic figure. 
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Activity 16: Rotation of a Polygon 

Preparations 
• Open a new GeoGebra file. 
• Hide algebra window and input field if necessary. 
• Show the coordinate axes and the grid. 
• Open the Properties dialog for drawing pad:  

o On tab Axes – xAxis change the Distance for x-Axis to 1 
o On tab Axes – yAxis change the Distance for y-Axis to 1 

Construction process 

1  Create an arbitrary triangle ABC 

2  New point D at the origin of the coordinate system 

3  Rename the new point to O 

  
Hint: GeoGebra offers a ‘fast-renaming’ option. Activate Move 
mode and select the object. When you start typing the new name 
GeoGebra opens the Rename dialog window. 

4  Create a slider for angle α 

  Hint: In the slider dialog window check Angle and set the increment 
to 90˚. 

5  Rotate triangle ABC around point O by angle α 

  Hint: Check counter clockwise rotation. 

7  Segments AO and A’O 

8  Angle AOA’ 

  Hint: Select the points in counter clockwise order. Hide the label of 
this angle. 

9  Move slider and check the image of the triangle 

Enhancing the construction 

1  Insert static text: Rotation of a Polygon 

2  Insert dynamic text: “A = ” + A  
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3  Insert dynamic text: “A’ = ” + A’ 

4  Move slider and text to desired positions 

5  Fix the position of the slider (Properties dialog – tab Slider) 

7  Fix the position of the text (Properties dialog – tab Basic) 

 

 
 

Discussion 
How could you use this file to introduce the concept of rotating an object around 
the origin of a coordinate system to your students? 
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9. Practice Block III 
This practice block consists of a pool of activities to practice inserting pictures 
and text into the graphics window of GeoGebra. Activities of two different 
difficulty levels are available: Basic tasks and Advanced tasks. You can pick 
tasks of your interest and work on them either on your own or together with a 
colleague. 

Tips and Tricks 

• For each of these activities, open a new GeoGebra file. Check prior to 
beginning the activity if you need to show or hide the algebra window, 
input field, and coordinate axes. 

• If you choose to work on an activity that involves inserting a picture into 
GeoGebra, make sure you have these picture files saved on your 
computer before you begin with the activity. 

• You might want to save your files before you start a new activity. 
• Don’t forget about the Undo and Redo buttons in case you make a 

mistake. 
• Frequently use the Move tool in order to check your construction (e.g. are 

objects really connected, did you create any unnecessary objects). 
• Make sure you know the syntax to enter algebraic expressions and 

functions. Read through the Tips and Tricks section in the beginning of 
topic Basic Algebraic Input, Commands, and Functions if you have 
troubles or ask colleagues for help. 

• Carefully check algebraic input before hitting the Enter key. If an error 
message appears, read it! It might help you to fix the problem. 

• Make sure, you know how to use corresponding geometry tools before 
you begin the construction. If you don’t know how to operate a certain tool, 
activate it and read the toolbar help. 

• If you have questions, please ask a colleague before you address the 
presenter or assistant(s). 

 
 



 

GeoGebra Introductory Workshop   
 

 

 46

Activity III.a: Visualizing a System of Equations 

Classification: Basic task 
 
In this activity you are going to use algebraic input and commands. Make sure 
you know the syntax for algebraic input and commands before you begin. 
 
You might want to have a look at the dynamic worksheet called 
A_3a_system_equations.html in order to find out how your students could use 
this construction to learn how to graphically solve a system of linear equations. 
 

Construction process 
1. Create sliders m_1 and b_1 using the default settings for sliders. 
2. Create the linear equation l_1: y = m_1 x + b_1. 
3. Create sliders m_2 and b_2 using the default settings for sliders. 
4. Create the linear equation l_2: y = m_2 x + b_2. 
5. Create dynamic text1: “Line 1: y = ” + l_1 
6. Create dynamic text2: “Line 2: y = ” + l_2 
7. Construct the intersection point A of both lines either using tool  

Intersect two objects or command A = Intersect[l_1, l_2]. 
8. Create dynamic text3: “Solution: x = ” + x(A)  

Hint: x(A) gives you   
the x-coordinate of 
point A. 

9. Create dynamic text4: 
“y = ” + y(A)  
Hint: y(A) gives you 
the y-coordinate of 
point A. 

 
 
 
 
 
Challenge: Create a similar construction that allows for visualizing the graphical 
solution of a system of quadratic polynomials. 
Hint: Functions need to be entered using the syntax f(x) = … 
 
Note: Such a dynamic figure can also be used to visualize an equation in one 
variable by entering each side of the equation as one of the two functions. 
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Activity III.b: Translating Pictures 

Classification: Basic task 
 
In this activity you are going to use the following tools and commands. Make sure 
you know how to use every single tool and command before you begin.  
 

 Insert image  Vector between two points        New! 

 A = (1, 1)  Translate object by vector         New! 

 Polygon  Move 

 Vector[O, P]  Text 
 

Construction process 
1. Open a new GeoGebra file. Show the algebra window, input field, 

coordinate axes, and grid. In the Options menu set the point capturing to 
on (Grid). 

2. Insert picture Bart.png into the first quadrant. 
3. Create points A = (1, 1), B = (3, 1), and D = (1, 4). 
4. Set point A as the first, B as the second, and D as the fourth corner point 

of the picture (Properties dialog, tab Position). 
5. Create triangle ABD. 
6. Create point O = (0, 0) and point P = (3, 1). 
7. Create vector u = Vector[O, P].  

Hint: You could also use tool  Vector between two points. 
8. Translate the picture by vector u using tool  Translate object by vector.  

Hint: You might want to reduce the filling of the image. 
9. Translate the three corner points A, B, and D by vector u. 
10. Create triangle A’B’D’. 
11. Hide point O so it can’t be moved 

accidentally. Change the color 
and size of objects to enhance 
your construction. 

 
Challenge 
Insert dynamic text that shows  

• the coordinates of points A, B, C, 
A’, B’, and D’. 

• the coordinates of vector u. 
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Activity III.c: Constructing a Slope Triangle 

Classification: Advanced task 
 
In this activity you are going to use the following tools and algebraic input. Make 
sure you know how to use every single tool and the syntax for algebraic input 
before you begin.  
 

 Line through two points  run = x(B) - x(A) 

 Perpendicular line  slope = rise / run 

 Intersect two objects Text 

 Polygon Midpoint or center 

 rise = y(B) - y(A) Move 
 

Construction process 
1. Show the algebra window, coordinate axes, and the grid. Set point 

capturing to On grid and the labeling to All new objects. 
2. Create a line a through two points A and B. 
3. Construct a perpendicular line b to the x-axis through point A. 
4. Construct a perpendicular line c to the y-axis through point B. 
5. Intersect perpendicular lines b and c to get intersection point C.  

Hint: You might want to hide the perpendicular lines. 
6. Create polygon ACB and hide the labels of the sides. 
7. Calculate the rise: rise = y(B) - y(A)  

Hint: y(A) gives you the y-coordinate of point A. 
8. Calculate the run: run = x(B) - x(A)  

Hint: x(B) gives you the   
x-coordinate of point B. 

9. Insert dynamic text1:   
"rise = " + rise  

10. Insert dynamic text2:   
"run = " + run 

11. Enter the following equation 
into the input field to 
calculate the slope of line a:  
slope = rise / run 

12. Insert dynamic text3: 
“slope = “ + slope 

13. Change properties of objects in order to enhance your construction. 
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Enhancing the construction 
Challenge 1: Insert a dynamic text that contains a fraction. 
Using LaTeX formulas, text can be enhanced to display fractions, square roots, 
or other mathematical symbols. 
 

1. Activate tool  Insert text and click on the drawing pad. 
2. Type slope = into the Insert text window’s input field. 
3. Check LaTeX formula and select a/b from the drop-down list. 
4. Place the cursor within the first set of curly braces. Select number rise in 

the algebra window.  
5. Place the cursor within the second set of curly braces. Select number run 

in the algebra window. 
6. Click Apply. 

 
 
 
Challenge 2: Attach text to an object 
Whenever an object changes its position, attached text adapts to the movement 
and follows along. 
 

1. Create midpoint D of the vertical segment using tool  Midpoint or center. 
2. Create midpoint E of the horizontal segment. 
3. Open the Properties dialog and select text1 (rise = …). Click on tab 

Position and select point D from the drop-down list next to Starting point. 
4. Select text2 (run = …) in the Properties dialog and set point E as starting 

point. 
5. Hide the midpoints D and E. 
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 Activity III.d: Exploring the Louvre Pyramid 

Classification: Advanced task 
 
In this activity you are going to use the following tools and some algebraic input. 
Make sure you know how to use every single tool and the syntax for algebraic 
input before you begin. Also, check if you have the picture A_2d_Louvre.jpg 
saved on your computer. 
 

 Insert picture  Perpendicular line 

 Line through two points  Intersect two objects 

 Slope  Show / hide object 

 Angle  Segment  

 New point  Move 
 
 
The Louvre in Paris is one of the most visited and famous art museums in the 
world. The building holds some of the world's most famous works of art, such as 
Leonardo da Vinci's Mona Lisa. In 1989 the main entrance of the museum was 
renovated and a glass pyramid was built1.  

Determine the slope of the pyramid’s faces 
1. Set point capturing off. Set the decimal 

places to 1. Change the labeling setting to 
All new objects (menu Options). 

2. Insert the picture A_2d_Louvre.jpg into 
the first quadrant of the coordinate 
system. The left lower corner should 
match the origin. 

3. Reduce the filling of the picture (about 50%) and set it as background 
image (Properties dialog). 

4. Create a line through two points with the fist point at the base and the 
second point at the vertex of the pyramid.  
Hint: Change the properties of line to improve its visibility. 

5. Use the  Slope tool to get slope triangle of line.  
Hint: Change the properties of slope triangle to improve its visibility.  
Hint: The slope triangle is attached to the point created first. 

6. Task: Determine the slope of the pyramid’s faces in percent.  

                                            
1 Information from http://en.wikipedia.org/wiki/Louvre, February 20, 2008 
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7. Create the angle between the x-axis and the line.  
Task: Determine the inclination angle for the pyramid’s face. 

Challenge 
The pyramid’s base is quadratic with a side length of 35 meters. Determine the 
height of the pyramid using similar triangles. 
 

1. Create a new point C on the line. 
2. Construct the slope triangle of the line using points C and B at the 

pyramid’s vertex.  
Hint: Create a line perpendicular to the y-axis through point C and a line 
perpendicular to the x-axis through point B at vertex of pyramid.  
Create the intersection point D of the two lines.  
Hint: Hide the auxiliary lines.  

3. Use segments to connect point D with points B and C.  
Hint: Change the properties of the segments to increase their visibility. 
Hint: You might want to rename the vertical segment to height and the 
horizontal segment to halfBase. 

4. Move point C along the line until the horizontal segment of the triangle 
matches the level of the road in front of the pyramid. 

5. Task: Calculate the height of the pyramid using similar triangles.  
Hint: Use the slope triangle and your new triangle. Remember that the 
base side length is 35 m. 

 
Check your answer with GeoGebra 

6. Show name and values of segments 
height and halfBase. 

7. Drag point C until the vertical 
segment has length 35/2 = 17.5.  
Hint: You might need to zoom out of 
the construction and / or move the 
drawing pad in order to be able to do 
this. 

8. Check if the height of the pyramid 
matches your answer. 

 
Comment 
By implementing the instructions above you were able to graphically determine 
the approximate value for the pyramid’s height. In reality, the Louvre pyramid has 
a base length of 35 m and a height of 21.65 m. Its faces have a slope of 118% 
and an inclination angle of about 52°.2 

                                            
2 Information from http://de.wikipedia.org/wiki/Glaspyramide_im_Innenhof_des_Louvre#Daten, 
February 22, 2008 


